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1. WYMOGI BEZPIECZEŃSTWA 
 

Poniższe wymogi bezpieczeństwa nie zawierają wszystkich informacji dotyczących działania 

urządzenia. Należy się zapoznać z niniejszą instrukcją obsługi w całości! 

 

UWAGA: Wszelkich podłączeń i zmian należy dokonywać przy odłączonym napięciu 

zasilającym. 

 

UWAGA:  Instalacja oraz programowanie urządzenia wymagają posiadania odpowiednich 

umiejętności, dlatego mogą być dokonywane tylko przez wykwalifikowany 

personel po zapoznaniu się w całości z instrukcją obsługi. 

 

UWAGA:  W przypadku, gdy urządzenie ulegnie uszkodzeniu należy skontaktować się ze 

sprzedawcą lub osobą odpowiedzialną za instalację.  
 

UWAGA:  Należy się upewnić czy zainstalowano odpowiednie zabezpieczenia na przewodach 

zasilających urządzenie, aby zapobiec jego uszkodzeniu. 

 

UWAGA:  Nieprawidłowo podłączone urządzenie może ulec uszkodzeniu. 

 

UWAGA:  Odpowiedzialność za prawidłową instalację urządzenia spoczywa na osobie 

montującej. Należy się upewnić czy spełnione zostają wszystkie wytyczne i normy 

obowiązujące w danym kraju.  

 

UWAGA: Wyładowania elektrostatyczne mogą uszkodzić urządzenie. Należy stosować 
odpowiednie zabezpieczenia. 

 

UWAGA: Wszelkie nieautoryzowane przeróbki, modyfikacje oraz próby naprawy powodują 
utratę gwarancji.  
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2. Wstęp 

 

 
Podtynkowy trzykanałowy ściemniacz oświetlenia LED służy do regulowania jasności tego typu 

oświetlenia. Ściemniacz przeznaczony jest do regulacji jasności żarówek LED 12V DC lub 

zespołów diod  z wbudowanym ograniczeniem prądowym. 

 

Urządzenie nie jest przeznaczone do regulacji jasności żarówek LED zasilanych napięciem 

220V AC oraz diod lub ich zespołów nie posiadających wbudowanego ograniczenia 

prądowego. 
 

Urządzenie przewidziane jest do zastosowania w instalacjach inteligentnych budynków, gdzie 

określona liczba ściemniaczy oświetlenia LED odpowiada za sterowanie oświetleniem budynku. 

Ściemniacz jest sterowany protokołem Modbus. Jest to standard przemysłowy w dziedzinie 

automatyki, którego dokumentacja jest w pełni jawna (znajduje się pod adresem 

http://www.modbus-ida.org/). Dzięki temu urządzenia oparte na protokole Modbus można 

wykorzystać w każdym systemie obsługującym ten standard. 

 

Urządzenie umożliwia sterowanie trzema niezależnymi kanałami oświetlenia LED. Maksymalny 

prąd obciążenia jednego kanału wynosi 2.5A i nie jest wewnętrznie ograniczony. Urządzenie 

zabezpieczone jest przed przeciążeniem bezpiecznikiem topikowym (F1 – 8A).  Ściemniacz LED 

może być zasilany napięciem 12V DC +/-10%. Ściemniacz wymaga do 100 mA (typowo: 50 mA) 

prądu na własne potrzeby. Należy zwrócić uwagę, że diody LED zasilane są z tego samego źródła,  

co ściemniacz. W ściemniaczu można ustawić 1000 poziomów jasności. Częstotliwość nośna  

PWM jest stała i wynosi 500Hz. Szybkość zmian oświetlenia jest także regulowana, od niemal 

natychmiastowego zapalania/gaśnięcia do trwającego 1 minutę 40 sekund rozjaśniania/ściemniania.  

 

 

 
Rys. 1. Widok ściemniacza LED SCL-3P 

 

 

3. Dane Techniczne 
 

 

Tabela 1. Parametry graniczne 

Nazwa parametru Uwagi Min. Max. 

Napięcie zasilania 

12V DC 
Notka 1 8V DC 18V DC 

Temperatura Notka 1 -20ºC 90ºC 
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Notka 1: Przekroczenie parametrów granicznych może spowodować uszkodzenie 

urządzenia, lub/i trwałe obniżenie parametrów. Długotrwała praca w warunkach bliskich 

parametrom granicznym może spowodować nieprawidłowe działanie układu, a nawet 

uszkodzenie urządzenia. 

 

 

Tabela 2. Rekomendowane warunki pracy 

Nazwa parametru Wartość 

Dopuszczalny prąd 1 kanału Max. 2.5A 

Napięcie zasilania 12V DC 12 V DC 

Temperatura pracy 0 – 70
o
C 

Wilgotność(1) 
5 – 95% 

Wysokość 0 – 2000 m n.p.m. 

Notka 1: Wilgotność bez kondensacji 

 

 

 
4. Instalacja. 

 

4.1. Podłączenie obwodu elektrycznego. 

4.1.1 Rozmieszczenie konektorów ściemniacza LED SCL-3P. 
 

 
Rys. 2. Rozmieszczenie konektorów ściemniacza LED SCL-3P. Widok płytki. 

 

Opis konektorów: 

 
J1:   Złącze zasilająco - wyjściowe 

J2:   Złącze komunikacyjne 

SW1:  Przełącznik adresu, prędkości transmisji danych i trybu Modbusa ściemniacza LED 

F1:  Wymienny bezpiecznik topikowy 8A 
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Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę i/lub 

uszkodzenie urządzenia nie objęte gwarancją! 
 

4.1.2 Złącze komunikacyjne J2.  
 

 
Rys. 3. Widok złącza komunikacyjnego J2 ściemniacza LED SCL-3P 

 

Tabela 3. Opis wyprowadzeń złącza J2: 

Numer 

wyprowadzenia 

Funkcja 

1  D- 

2  D+ 

3  GND 

 

4.1.3 Złącze zasilająco - wyjściowe J1 ściemniacza LED SCL-3P 
 

 
Rys. 4. Widok złącza zasilająco - wyjściowego J1 ściemniacza LED SCL-3P. 

 

Tabela 4. Opis wyprowadzeń złącza J1: 

Numer 

wyprowadzenia 

Funkcja 

1  +12V 

2  GND 

3  OUT1+ 

4 OUT1- 

5 OUT2+ 

6  OUT2- 

7  OUT3+ 

8  OUT3- 
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4.1.4 Przykład typowego podłączenia do sterownika PLC firmy FATEK 
 

Na rysunku 5 pokazano przykład typowego podłączenia ściemniacza LED SCL-3P do sterownika 

PLC firmy Fatek przy pomocy interfejsu RS485.  
 

 
Rys. 5. Przykład typowego podłączenia ściemniacza LED SCL-3P do sterownika PLC. 



 

 8  

 

4.2 Instalacja mechaniczna, wymiary  
 

Na rysunku 6 pokazano wymiary ściemniacza LED SCL-3P.  

 

 
Rys. 6. Wymiary ściemniacza LED SCL-3P 

 

 

5. Konfiguracja 
 

5.1. Działanie urządzenia 
 

W momencie włączenia urządzenia CPU wykonuje test urządzenia, a także odczytuje parametry 

konfiguracyjne – ustawiony adres, prędkość komunikacji, oraz tryb Modbus. Po około 1s od 

włączenia zasilania urządzenie jest gotowe do pracy. Ściemniacz posiada 12 rejestrów Modbus. Są 
one zaimplementowane jako Holding Registers (4x) i InputRegisters (3x) . 

 

Lista rejestrów Modbus ściemniacza:  

 
31100 Autodetekcja 134 

31101 Ilość kanałów 3 

31101 Wersja FW 101 

41200 Jasność kanał 1 

41201 Krok kanał 1 

41202 Jasność  kanał 2 

41203 Krok kanał 2 

41204 Jasność kanał 3 

41205 Krok kanał 3 

41206 Bieżąca jasność 1 kanał 1 

41207 Bieżąca jasność 2 kanał 2 

41208 Bieżąca jasność 3 kanał 3 
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5.2. Opis rejestrów Modbus 

 
Rejestr „Autodetekcja” zawiera wartość identyfikującą urządzenie jako trzykanałowy ściemniacz 

LED (134). Rejestr „Wersja FW” zawiera numer wersji oprogramowania znajdującej się 
w ściemniaczu, w formacie xxx. Aby otrzymać rzeczywisty numer wersji oprogramowania należy 

dodać kropki między xxx. Czyli odczytany numer wersji oprogramowania 101, to rzeczywista 

wersja firmware 1.0.1.  
 

Pojedynczy obwód oświetlenia sterowany jest przez dwa rejestry Modbusa: „Jasność” i „Krok”. 

Parametr „Jasność” odpowiada za jasność oświetlenia i może przyjmować wartości 0..1000, gdzie 

0 oznacza oświetlenie wyłączone, a 1000 - pełną jasność. Wartości pośrednie odpowiadają 
pośrednim stopniom jasności, np. wartość 500 odpowiada jasności połowicznej. 

 

Parametr „Krok” odpowiada za szybkość zmian jasności. Może on przyjmować wartości od 0 do 

100, gdzie 0 to zmiana natychmiastowa, 1 – zmiana najszybsza, a 100 – zmiana najwolniejsza. 

Krok równy 1 oznacza, iż ściemniacz zmienia jasność o 1 poziom w ciągu 1ms (milisekundy). Krok 

równy 100 oznacza zmianę o 1 poziom w ciągu 100ms. 
 

Wartość w rejestrze „Bieżąca jasność” informuje o tym, jaka jest w danej chwili jasność kanału. 

Gdy jasność kanału osiągnie ustalony poziom, wartość w rejestrze „Jasność” będzie równa wartości 

w rejestrze „Bieżąca jasność”. W czasie, gdy ściemniacz zmienia jasność z ustawionej wcześniej na 

ustawioną później, wartość rejestru „Bieżąca jasność” zmienia się z wartości ustawionej wcześniej 

na wartość ustawioną później. Można to wykorzystać do wykrywania momentu osiągnięcia zadanej 

jasności. 

 

Tabela 5. Czas trwania zmian jasności oświetlenia  

w zależności od wartości kroku 

Lp. 
Wartość 

kroku 

Zmiana 

jasności 

o 1 poziom 

w ciągu …  

[ms] 

Całkowity czas 

ściemniania/ 

rozjaśniania od 

0..1000 [s] 

1 0 0 0 

2 1 1 1 

3 2 2 2 

4 3 3 3 

5 4 4 4 

6 5 5 5 

7 6 6 6 

8 7 7 7 

9 8 8 8 

10 9 9 9 

11 10 10 10 

12 11 11 11 

13 12 12 12 

14 13 13 13 

15 14 14 14 

16 15 15 15 

17 16 16 16 

18 17 17 17 

19 18 18 18 

20 19 19 19 



 

 10  

21 20 20 20 

22 21 21 21 

23 22 22 22 

24 23 23 23 

25 24 24 24 

26 25 25 25 

27 26 26 26 

28 27 27 27 

29 28 28 28 

30 29 29 29 

31 30 30 30 

32 31 31 31 

33 32 32 32 

34 33 33 33 

35 34 34 34 

36 35 35 35 

37 36 36 36 

38 37 37 37 

39 38 38 38 

40 39 39 39 

41 40 40 40 

42 41 41 41 

43 42 42 42 

44 43 43 43 

45 44 44 44 

46 45 45 45 

47 46 46 46 

48 47 47 47 

49 48 48 48 

50 49 49 49 

51 50 50 50 

                            …………….dalej analogicznie 
 

5.3. Diody sygnalizacyjne ściemniacza LED SCL-3P. 
 

 
Rys. 7. Diody sygnalizacyjne ściemniacza LED SCL-3P. 

 

 

 

Tabela 6. Diody sygnalizacyjne 

Numer diody Kolor Nazwa Opis 

D1 zielony RX Sygnalizuje odbieranie, jeśli miga 

D2 czerwony TX Sygnalizuje nadawanie, jeśli miga 

D3 czerwony CPU Sposób migania diody sygnalizuje 

poprawną pracę CPU lub kod błędu. 
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Nieprzerwane świecenie się obu diod (TX, RX), lub tylko jednej (RX lub TX) sygnalizuje 

możliwość błędu w podłączeniu przewodów sygnałowych do gniazda zasilająco-komunikacyjnego 

lub błędnego ustawienia adresu ściemniacza. Miganie tylko diody sygnalizującej odbieranie danych 

przez ściemniacz sygnalizuje możliwość ustawienia błędnego adresu, wybranie błędnych 

parametrów transmisji (nieprawidłowa prędkość, ustawienia parzystości, liczba bitów stopu, itp.). 

Regularne miganie diody D3 sygnalizuje poprawną pracę urządzenia. W przypadku, gdy 

w urządzeniu lub jego ustawieniach wystąpi błąd, dioda D3 służy do sygnalizacji kodu błędu, 

w szczególności jeżeli uniemożliwia on transmisję przez interfejs Modbus. Są to tzw. wolne kody 

błędów. Lista kodów błędów wraz z opisem znajduje się w tabeli poniżej: 

 

 

Tabela 7. Lista kodów błędów 

Lp. Numer Nazwa Opis Sposób postępowania 

1 2 
Cannot initialize 

Modbus RTU 

Nie można uruchomić 
protokołu Modbus RTU 

Należy sprawdzić, czy 

adres urządzenia nie jest 

ustawiony na 0 

2 3 
Cannot initialize 

Modbus ASCII 

Nie można uruchomić 
protokołu Modbus ASCII 

Należy sprawdzić, czy 

adres urządzenia nie jest 

ustawiony na 0 

3 4 
Enable Modbus stack 

failed 
Błąd wewnętrzny 4 

4 5 Main returned Błąd wewnętrzny 5 

5 6 NMI Handler Błąd wewnętrzny 6 

6 7 HardFault Błąd wewnętrzny 7 

7 8 Unexpected interrupt Błąd wewnętrzny 8 

Jeżeli po zresetowaniu 

urządzenia błąd występuje 

nadal, należy 

skontaktować się z 

producentem/ instalatorem 

 

 

 

Na rys.8 pokazano graficznie błąd o kodzie 2.  

 

 
 

Rys. 8. Graficzne przedstawienie przykładowego kodu błędu 

 

 

 

 

 

 

 

 

 

 

 



 

 12  

5.4. Zworki konfiguracyjne. 

 

5.4.1. Ustawianie adresu Modbusa za pomocą switcha SW1 

 

 
 

Rys. 9 Zworki SW1 do ustawiania adresu Modbus (zworki 1-6).  

Na rysunku przedstawiono 31 z 63 możliwych ustawień adresu. 

 

W położeniu przedstawionym na widoku płytki, zworka w pozycji OFF oznacza 1, zworka 

w pozycji ON – 0.  

 

 

W switchu SW1 zworki 1..6 służą do ustawienia adresu w protokole Modbus (A0..A5) ściemniacza 

LED SCL-3P: 

1 – A0 (najmniej znaczący bit adresu - LSB) 

2 – A1 

3 – A2 

4 – A3 

5 – A4 

6 – A5 (najbardziej znaczący bit adresu - MSB) 

 

 

Adres ściemniacza LED SCL-3P w protokole Modbus: 

- ustala się sprzętowo za pomocą switcha SW1,  

- może przyjmować wartości 1..63,  

- adres 0 jest zarezerwowany w specyfikacji protokołu Modbus jako rozgłoszeniowy (broadcast),  

- ustawia się w postaci binarnej, tzn. 27 (dec) = 011011 (bin). Switch w pozycji ON to bit adresu 

ustawiony jako 0. Switch w pozycji OFF to bit adresu ustawiony jako 1.  

 

 

 



 

 13  

 

 

5.4.2. Ustawianie trybu Modbusa za pomocą switcha SW1 

 
Zworka 7 (z zestawu SW1) służy do ustawiania trybu Modbusa. 

0 – Modbus RTU 

1 – Modbus ASCII  

 

5.4.3. Ustawianie prędkości transmisji za pomocą switcha SW1 
 

Zworka 8 (z zestawu SW1) służy do ustawiania prędkości transmisji: 

0 – prędkość 9600 baud  

1 – prędkość 57600 baud 

 

Uwaga: W ściemniaczu i urządzeniu nim sterującym muszą być ustawione takie same 

parametry transmisji! 
 

Uwaga: Aby zmienić adres płytki, tryb Modbus lub prędkość komunikacji, należy ustawić 
żądany adres, tryb i prędkość, a następnie wyłączyć i włączyć zasilanie. Zmiana adresu, trybu 

i prędkości przy włączonym zasilaniu nie odniesie skutku aż do następnego wyłączenia 

i włączenia zasilania. Ustawienie adresu płytki na 0 spowoduje nieprawidłową pracę 
ściemniacza. 

 
5.5. Protokół transmisji danych 

 
Ściemniacz LED SCL-3P komunikuje się z urządzeniem sterującym za pomocą protokołu Modbus. 

W warstwie fizycznej połączenie jest realizowane za pomocą dwuprzewodowego interfejsu RS-485 

z transmisją half-duplex.  

 

 

      Tabela 8. Parametry transmisji w trybie RTU: 

Prędkość: 9600/57600 baud (przełączane zworką) 
parzystość: Even 

ilość bitów danych: 8 

ilość bitów stopu: 1 

 

 

      Tabela 9. Parametry transmisji w trybie ASCII: 

prędkość: 9600/57600 baud (przełączane zworką) 
parzystość: Even 

ilość bitów danych: 7 

ilość bitów stopu: 1 

 

 

Uwaga: W ściemniaczu LED i urządzeniu nim sterującym muszą być ustawione takie same 

parametry transmisji! 
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6. Przykład konfiguracji ściemniacza LED SCL-3P ze sterownikiem PLC    

firmy Fatek 

 
Aby nawiązać komunikację ze ściemniaczem LED SCL-3P poprzez port RS-485, należy najpierw 

skonfigurować port w sterowniku PLC. Możemy tego dokonać za pomocą programu  

WinProLadder. 

 

Wybieramy z menu PLC → Setting → Port (numer portu, po którym będzie odbywała się 
komunikacja).  

 

 
 

Rys.10 Wybór portu komunikacyjnego w sterowniku PLC 

 

Po wybraniu odpowiedniego portu następnie musimy go skonfigurować. Ustawiamy parametry 

transmisji: 

1. prędkość (Baud Rate):    9600/57600 (ustawiane zworką)  
2. parzystość (Parity)   even 

3. ilość bitów danych (Data Bit):   8 

4. ilość bitów stopu: (Stop Bit)  1 

5.   protokół      Modbus RTU (slave) 
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Rys. 11 Konfiguracja portu komunikacyjnego sterownika PLC, w trybie RTU 

(zgodnie z ustawieniami zworki w SCL-3P). 

 

Po wybraniu odpowiedniego portu musimy go skonfigurować. Ustawiamy parametry transmisji: 

1. prędkość (Baud Rate):   9600/57600 (ustawiane zworką)  
2. parzystość (Parity)   even 

3. ilość bitów danych (Data Bit):  7 

4. ilość bitów stopu: (Stop Bit)  1 

5. protokół     Modbus ASCII (slave) 

 

 
Rys. 12 Konfiguracja portu komunikacyjnego sterownika PLC, w trybie ASCII 
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Sterownik ustawiony jako „master” musi mieć uruchomioną funkcję M_BUS (funkcja 150). 

W funkcji 150.M_BUS użytkownik ustawia tylko port, którego będzie używał do komunikacji, 

rejestr startowy programu do komunikacji oraz rejestr roboczy.  

 

Funkcja 150.M_BUS 

 
Rys. 13 Symbol funkcji M_BUS 

 

 

Pt:     Numer portu, który ma być użyty do komunikacji 

SR:     Rejestr startowy  

WR:     Rejestr roboczy  

Jeżeli wejście A/R = 0    - protokół Modbus 

Jeżeli wejście A/R = 1    - protokół Modbus ASCII 

Jeżeli wejście ABT zmieni się na 1, operacja zostaje przerwana i po jej wznowieniu przesyłanie 

zaczyna się od pierwszego pakietu danych. 

 

Kiedy już zostanie skonfigurowany port oraz wstawiona funkcja 150.M_BUS,  musimy stworzyć 
tabelę. Z menu wybieramy Project → Modbus Master Table → Add Modbus Master Table. 

 

 

 
Rys. 14. Widok ekranu przy wstawianiu z menu tabeli do obsługi Modbusa w programie 

WinProladder. 
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Rys. 15. Widok ekranu przy wstawianiu z drzewa konfiguracji tabeli do obsługi Modbusa  

w programie WinProladder. 

 

 

Po wybraniu Add Modbus Master Table pojawi się okno Table Edit.  

 

 

 
Rys. 16 Okno konfiguracji funkcji Modbus w sterowniku PLC. 

 

 

W polu Table Name użytkownik może wpisać dowolną nazwę np. Modbus, natomiast 

w polu Table Starting Address należy wpisać rejestr startowy, który został użyty w programie 

w funkcji 150.M_BUS, np. R1000. Następnie po pojawieniu się okna Modbus Master Table można 

dodawać komendy.  
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Rys. 17 Okno edycji komend w komunikacji Modbus 

 

Po naciśnięciu przycisku Add pojawia się okienko „Command Item”, w którym należy wprowadzić 
numer stacji Slave Station (adres ściemniacza LED) inny niż numer stacji „master”, na której 

używa się funkcji M_BUS. Następnie wybrać rodzaj komendy, rozmiar przesyłanych danych, adres 

startowy w sterowniku „master” oraz adres startowy w ściemniaczu lub innym urządzeniu „slave”. 

 

Przykładowa konfiguracja: 

 

Zapis danych do kanałów 

Slave Station:   2 (adres fizyczny ściemniacza LED SCL-3P równy 2) 

Command:    Write (Zapis) 

Data Size:   6 ((poziom jasności, krok zmiany)* 2 kanały)  

Master Data Start Address: np. R400 (wysyła wartości znajdujące się w rejestrach R400..R405) 

Slave Data Start Address: 401200  

Master Data Start Address:  Początek tabeli danych w PLC 

Slave Data Start Address:  Początek tabeli danych w ściemniaczu 

 

Odczyt autokonfiguracji 

Slave Station:   2 (adres fizyczny ściemniacza LED SCL-3P równy 2) 

Command:    Read (Odczyt) 

Data Size:   3 (autokonfiguracja + wersja FW + ilość kanałów) 

Master Data Start Address: np. R412 (wczytuje dane do rejestrów R412..R414) 

Slave Data Start Address: 301100  

Master Data Start Address:  Początek tabeli danych w PLC 

Slave Data Start Address:  Początek tabeli danych w ściemniaczu 

 

Odczyt bieżącej jasności 

Slave Station:   2 (adres fizyczny ściemniacza LED SCL-3P równy 2) 

Command:    Read (Odczyt) 

Data Size:   3  

Master Data Start Address: np. R415 (wczytuje dane do rejestrów R415..R417) 

Slave Data Start Address: 401206 

Master Data Start Address:  Początek tabeli danych w PLC 

Slave Data Start Address:  Początek tabeli danych w ściemniaczu 
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7. Przykład konfiguracji ściemniacza LED SCL-3P z panelem HMI firmy Weintek 

 
Podłączamy ściemniacz LED SCL-3P do panelu HMI według następującego schematu: 

 

 
Rys. 18. Schemat podłączenia ściemniacza LED SCL-3P do panelu HMI firmy Weintek 

 

Aby ściemniacz LED SCL-3P współpracował z panelem HMI, należy odpowiednio skonfigurować 
panel w programie EasyBuilder. 

 

Tworzymy nowy plik (Menu: File → New) (rys.18): 

 

 
Rys. 19: Okno ustawień początkowych programu. 
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Po wybraniu odpowiedniego urządzenia (pole "Model", przykładowo "MT6050i (480 x 272)") oraz 

rodzaju wyświetlania (poziomo – "Landscape" lub pionowo "Portrait") automatycznie pojawia się 
okno "System Parameter Settings" (rys.26). Jeśli okno nie otworzy się automatycznie, można je 

otworzyć ręcznie (Menu: Edit → System Parameters).  

 

 
Rys. 20: Okno ustawień parametrów systemu (po zmianach). 

W zakładce "Device" znajduje się lista aktualnie obsługiwanych urządzeń (domyślnie na liście jest 

panel dotykowy, który konfigurujemy). Aby program obsługiwał panel dotykowy wraz ze 

ściemniaczem, należy dodać nowe urządzenie do listy (przycisk "New" w zakładce "Device") 

(rys.20). 
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Rys. 21: Okno ustawień urządzenia (po zmianach). 

 

Przykładowa konfiguracja dla ściemniacza: 

 

Name:   Nazwa (dowolna nazwa wybrana przez użytkownika) 

Location:   Local 

PLC type:   MODBUS RTU  

PLC I/F:   RS-485 2W 

COM:   COM1 (9600,E,8,1) – można zmienić te ustawienia, klikając "Settings" 

(rys.21). 
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Rys. 22: Okno zmiany parametrów transmisji danych (po zmianach). 

 

Po skonfigurowaniu połączenia, pojawia się wirtualne okno panelu HMI. Możemy rozmieszczać na 

nim okienka (przygotowane przez producenta) umożliwiające komunikację z urządzeniami 

i sterowanie ściemniaczem. Parametry ściemniacza możemy zmieniać np. poprzez klawiaturę 
ekranową. Aby umieścić obiekt tego typu na wirtualnym ekranie, należy wybrać "Numeric Input" 

z menu (rys.22). 

 

 
Rys. 23 Dodawanie elementu "Numeric Input". 
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Pojawia się okno konfiguracji klawiatury ekranowej (rys. 23)  

 

 
Rys. 24: Okno konfiguracyjne klawiatury ekranowej (po zmianach) 

 

Przykładowa konfiguracja: 

 

Description:  Nazwa identyfikacyjna określonej klawiatury 

PLC name:  MODBUS RTU 

Device type:  4x (16-bitowe Holding Registers)  

Address:  1201 (podajemy tylko ostatnie 4 cyfry) 

 

 
Rys. 25: Wygląd klawiatury  

na ekranie dotykowym. 
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Kolejne zakładki w oknie "New Numeric Input Objects" pozwalają na dokładniejsze 

skonfigurowanie klawiatury ekranowej (np. podanie zakresu wpisywanych liczb, zmianę wyglądu 

okienka na ekranie dotykowym, zmianę czcionki, zmianę umiejscowienia klawiatury na ekranie 

dotykowym itp.). Można ponownie otworzyć okno konfiguracyjne, podwójnie klikając na ramce 

reprezentującej dany obiekt (po jego umieszczeniu na wirtualnym ekranie). Kolejnym wygodnym 

i przejrzystym sposobem modyfikowania zmiennych jest suwak (slider). Wybieramy "Slider" 

z menu (podobnie jak w przypadku klawiatury ekranowej). 

 

Do konfiguracji suwaka służy okno "New Slider Object" – otwierane automatycznie (rys. 25). 

 

 
Rys. 26: Okno konfiguracyjne suwaka (po zmianach) 

 

Przykładowa konfiguracja: 

Description:   Nazwa identyfikacyjna określonej klawiatury 

PLC name:   MODBUS RTU 

Device type:   4x (16-bitowe Holding Registers)  

Address:   1200 (podajemy tylko ostatnie 4 cyfry) 

Address format: 16-bit (Unsigned) 

 

W zakładce "Outline" możemy ustawić parametry: zakres zmian, kolory, kształty itp. 

 

Kolejnymi ściemniaczami sterujemy tak samo. Kolejne klawiatury ekranowe konfigurujemy 

analogicznie jak w przykładzie powyżej, pamiętając jedynie o tym, by ustawiać odpowiednie 

adresy ściemniacza. Następnie zapisujemy program, kompilujemy i wysyłamy do naszego panelu 

(rys. 26). 
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Rys. 27: Zapis projektu i zaprogramowanie panelu dotykowego. 

 

Po poprawnym podłączeniu panel będzie sterować ściemniaczem w pełni samodzielnie. 

 

8. Historia wersji instrukcji 
 

Lp. Data Wersja Poprawki 

1 23.12.2010 1.0.0 Początek prac 

 

 

9. Uwagi końcowe 
 

1.  Producent zastrzega sobie prawo do wprowadzania ciągłych poprawek i ulepszeń. 
2.  Produkt może nieznacznie różnić się od fotografii. 

3.  Instrukcja może zawierać błędy. Producent nie odpowiada za jakiekolwiek uszkodzenia, które z 

nich mogą wyniknąć. Jednocześnie producent oświadcza, że dołoży wszelkich starań, by żadne 

błędy w instrukcji się nie pojawiły, a jeżeli tak się stanie, to informacje o wszelkich błędach 

zamieści na swojej stronie internetowej.  

4.  Producent nie odpowiada za żadne szkody wynikające z użytkowania urządzenia. 

5.  Aktualna wersja instrukcji znajduje się na stronie www.esea.pl. 

6.  Wszelkie uwagi dotyczące urządzenia oraz tej instrukcji proszę kierować na email: 

info@esea.pl.    

 


